
Lakehead University

Knowledge Commons,http://knowledgecommons.lakeheadu.ca

Electronic Theses and Dissertations Electronic Theses and Dissertations from 2009

2019

Assessing the effectiveness of airborne

thermal technology for delineating

environmental thermal effluent

Ciezadlo, Michael

http://knowledgecommons.lakeheadu.ca/handle/2453/4506

Downloaded from Lakehead University, KnowledgeCommons



 
 

 

 

 

 

Assessing the effectiveness of airborne thermal technology for delineating environmental 
thermal effluent 

By 

 

Michael Ciezadlo 

 

 

 

 

 

 

 

 

A thesis presented to Lakehead University in fulfillment of the thesis requirement for a 
degree of Master of Environmental Studies 

 

 

 

 

Thunder Bay, Ontario, Canada, 2019 

© Michael Ciezadlo 2019 

  



ii 
 

Authors Declaration 
 

I hereby declare that I am the sole author of this thesis. This is a true copy of this thesis, 
including any required final revisions, as accepted by my examiners. 

 

I understand that my thesis may be made electronically available to the public. 

  



iii 
 

Abstract 
 

Bruce Power Generating Station is located on the shores of Lake Huron and is 
responsible for generating 30% of the Province of Ontario’s electrical need on a daily 
basis. Lake Huron is the 5th largest freshwater lake by volume and provides cool lake 
water to cool the steam generated by the CANDU® reactors. The resulting thermal 
effluent is regulated and must be monitored to ensure the generating station does not 
exceed the values published in the operating certificate. Current monitoring is conducted 
through a series of surface temperature probes at strategic locations. Airborne thermal 
cameras provide a new dimension to thermal data acquisition and have been tested in 
smaller capacities on similar industrial complexes. This study compares data collected by 
surface probes, FireMapper 2.0 (a longwave frame-based thermal camera), longwave 
thermal data collected by Landsat 8 TIRS, and surface models generated using the 
CORMIX software suite. The results from this study suggest a strong correlation between 
the data collected by FireMapper 2.0 and Landsat 8 TIRS. The trend of the ground 
samples is similar to the data collected by FireMapper 2.0, but a large offset exists 
between the data sets. Furthermore, the CORMIX model is able to estimate the surface 
area occupied by thermal effluence, but the spatial bounds of the model require 
refinement. This study concludes that airborne thermal sensors are sensitive enough to 
collect useful thermal data for effluence delineation. Some further investigation is 
required on integrating navigation solutions to generate better accuracy within the 
FireMapper 2.0 frame-based solution. As well, the study area seemed to reach the extents 
of the capture abilities of FireMapper 2.0. Airborne thermal technology is worth 
considering for future effluent research. 
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1.0 - Introduction 

1.1 – Introduction to Bruce Power 

 Bruce Power Generating Station is located on the eastern shores of Lake Huron 

near Kincardine, Ontario, Canada. The facility consists of two separate generating 

stations: Bruce A and Bruce B; each of which consist of two Canadian Deuterium 

Uranium (CANDU®) Nuclear Reactors (Golder, 2004). Construction of the Bruce Power 

facility began in 1960, with the first reactor generating power in 1967 (Bruce Power, 

2017). Prior to 2001, the nuclear reactors were under the ownership of the provincially 

owned corporation, Ontario Power Generation (OPG). In 2001, Bruce Power Limited 

purchased the Kincardine facility from the Ontario Government making it the first 

privately owned Nuclear Generating facility in Canada. The fact that Bruce Power is 

privately owned does not change which regulations it must abide by or which agencies it 

must report to; but rather, it means the facility must manage balanced operations to 

ensure it remains in business. Today, Bruce Power is responsible for generating 30% of 

Ontario’s needs on a daily basis (Smith, et al., 2017).  

 Lake Huron is one of five Great Lakes in North America which assists in storing 

21% of the world’s fresh water. Lake Huron is the 5th largest fresh water lake by volume 

in the world with an average depth of 60 meters and a maximum depth of ~230 meters 

(Sheng and Rao, 2006). Various studies have concluded that Lake Huron has a well-

defined surface current that is seasonal in nature. Studies have determined that in the 

summer months a vortex develops in the centre of Lake Huron proper; whereas in the 

winter, this phenomenon is weaker, but still evident (Beletsky, Saylor and Schwab, 

1999). The Bruce Power site is unique in location as it is typically subjected to a 

predominant Northeast current regardless of season, that brings cooler water from the 

centre of the lake (Ullman, et al., 1998; Sheng and Rao, 2006; Beletsky, Saylor and 

Schwab, 1999). This convergent current is responsible for pushing coastal waters 

northwards along the shoreline towards Southampton, Ontario and beyond (Sheng and 

Rao, 2006). A study completed in 1998 by Ullman, et al., suggests that water 

temperatures near the Bruce Power facility typically remains below 4°C in the winter 
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months. During the spring, lake stratification is triggered when near shore waters exceed 

4°C as a result of shallow water heating. As the water column continues to heat, this 4°C 

isotherm begins to deepen causing convergent circulation. The apex of this process 

occurs when the entire water column is above 4°C. Although this process is well defined, 

it is totally dependent on the rate of change of the heat applied, the slope of the lake bed 

and the winter water temperature. 

 The method in which Bruce Power generates power is unique and heavily 

dependent on its geographic location in Ontario. The CANDU® reactors utilize a heavy 

water system to generate power, as outlined in Bruce Power’s Safety features of CANDU 

Reactors document drafted in 2001. To complete this task, energy is generated by the 

nuclear reactor core. The resulting heat generated by this reaction is then used to heat 

heavy water contained within a closed system to create steam. The steam is routed and 

utilized to move massive turbines which are responsible for converting the kinetic energy 

into electric energy. Since the heavy water system is closed, the steam used to move the 

turbines needs to be cooled and recycled. This is accomplished by routing the steam 

through a long network of condenser tubes that are cooled by ambient water from Lake 

Huron which facilitates the transformation of the heavy water from gas to liquid. The 

resulting “warmed” ambient water from the condensing phase is then recycled back into 

Lake Huron through two large discharge channels located to the North and South of the 

Bruce Power complex. Lake Huron acts as a source of cool water that can be cycled 

through the condensers to cool off the heavy water required to generate power. Figure 1.1 

provides a graphic summary of the physical process. 

 Intake water from Lake Huron is captured at one common point and is shared 

between both Bruce A and Bruce B complexes (Golder, 2005). Water is collected from 

the bottom of the water column off shore of the facility. After the condensing process, 

water from Bruce A is discharged towards the north of the facility where Bruce B waters 

are discharged to the south. This discharge water is typically warmer than the temperature 

of the ambient water and has been a point of concern with local populations and a variety 

of other interest groups (Golder, 2005). The thermal effluent entering Lake Huron is 

regulated and specific temperature thresholds have been set to ensure this water is not 
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posing a significant threat to the local ecosystem. Furthermore, Bruce Power has 

completed many proactive studies on the local ecology to better understand what effect 

the warm water leaving the facility has on various habitats (Smith, et al., 2017). 

 In recent decades, the Province of Ontario has led the push to slowly revitalize the 

generation infrastructure in Ontario with preference on “Green” energy initiatives 

(Ministry of Energy, 2013). Within this policy shift, preference is placed on renewable 

energy sources and less so on carbon heavy methods. Nuclear energy complicates the 

debate as it typically carries a negative stigma within the public eye as many high-profile 

disasters leave a lasting impression on the world. Regardless, nuclear energy is still one 

of the most efficient means to generate mass amounts of power with a minimal carbon 

footprint. Furthermore, society’s reliance on energy drives the requirement for increased 

energy output with minimal devastation to the environment. A prime example is during 

summer months when temperatures in Southern Ontario rise and there is a heavy reliance 

on air conditioning units to create comfortable living environments. A direct result of this 

creature comfort is the requirement for more power to fuel the grid. To accomplish this, 

Bruce Power typically needs to have more reactors online and operating at a higher 

capacity. Higher ambient temperatures result in warmer water temperatures and therefore 

Bruce Power must carefully maintain the balance of meeting societal needs for power 

while ensuring they do not exceed the environmental tolerance set out by the regulator. 
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Figure 1.1 

Simplified graphical representation of the interaction between ambient lake water from 
Lake Huron and the Bruce Power CANDU® reactor. Heavy water in a gaseous state is 
transported into the condenser where cool lake water from Lake Huron assists in 
removing the energy from the steam and returning it to liquid state. The cooled heavy 
water is then transported back to the steam generators for reuse in the power generation 
cycle. Heavy water transportation and usage is a closed system. The lake water used to 
cool the heavy water is then discharged back into Lake Huron via the discharge channel. 
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1.2 – The Global Perspective 

 With climate change science front and centre in many countries, there has been 

increased visibility on freshwater resources and how they should be managed across the 

globe. Power producers have been under increased scrutiny as it has become increasingly 

publicized that most forms of power generation require ambient water to cool these 

processes. To frame the interdependency between energy and water, it was calculated that 

90% of US power is derived from steam cycle power plants (i.e. nuclear and coal); which 

equates to 38% of the US freshwater withdrawal in 2010 (DeNooyer, et al., 2016). This 

statistic does not account for power generated through hydro dams which also is reliant 

on water and has some impacts on the environment. In comparison, power producers 

accounted for 43% of the freshwater withdrawal for similar processes in Europe in 2008 

(Gjorgiev and Sansavini, 2018). These statistics are staggering as climate patterns are 

changing and certain regions of the world have experienced extreme drought in recent 

years which has placed great importance on freshwater resources. Other methods for 

cooling steam type power generation cycles do exist (i.e. condensers for nuclear power 

plants), but they tend to carry a large stigma with the local populations and therefore are 

ruled out early on in many build cycles (DeNooyer, et al., 2016). 

 Surprisingly enough, Australia is one market where nuclear power has not 

capitalized. Like any other developed nation, Australia has a high reliance on energy and 

currently meets this demand through coal and natural gas generating facilities (Bird, et 

al., 2014). Nationally the country is split as there is high public opinion that these fossil 

fuel facilities need to be shut down due to airborne pollution, but there is an equally low 

opinion of switching to nuclear power generation. Part of this negative opinion is due to 

strong lobbying from fossil fuel interest groups and the remainder from the recent disaster 

in Fukushima Daiichi (Bird, et al., 2014). Australia does contain one of the world’s 

largest Uranium deposits and is the third largest exporter of this natural resource. 

Regardless, this has not swayed public opinion enough to push for aggressive 

development of nuclear facilities in Australia.  

 With populations increasing, the demand for power will increase as well. 

Developing policies and procedures and conducting research on the impact of effluent 
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water is critical and meaningful in a global context. Understanding how warmer water 

interacts with local ecosystems can assist in developing strategies that reduce or eliminate 

environmental impacts in new construction or developments. Furthermore, many nations 

have taken it upon themselves to implement a carbon-based economy that forces society 

to be accountable for pollutants. Much of the literature today is alluding to the fact that 

water will be the next economy that will be monetized and managed in the future to 

ensure it is being treated with respect (DeNooyer, et al., 2016, Gjorgiev and Sansavini, 

2018, Logan and Stillwell, 2018). By better understanding the interactions of these 

various facilities in localized geographies will help countries considering the construction 

of future energy projects. 

1.3 – Environmental Regulations 

 Bruce Power is not governed by a single body; but rather, must seek operating 

approvals with the appropriate regulating agency. For instance, power generation 

approvals are provided by the Federal Government in accordance with the Nuclear Safety 

and Control Act whereas water discharge temperatures are regulated by the Ministry of 

the Environment (MOE). In Ontario, the Government has established the Ontario 

Provincial Water Quality Objective (PWQO) which establishes what the Province 

believes is an acceptable limit for water temperature release throughout the Province. 

Within this policy it is generically stated that no persons or industry shall artificially 

increase the ambient temperature of water above 10°C without approval from the MOE. 

Furthermore, the objective states that any thermal discharge into water “shall not exceed 

30°C or the temperature of a representative control location plus 10 degrees or the 

allowed temperature difference, whichever is the lesser temperature”. This maximum 

value is typically defined as TMAX. Finally, the objective suggests that should an entity 

take and discharge water into the environment, multiple ecological monitoring practices 

must be established and monitored to ensure unnecessary stress is not placed on the 

environment (Fitchko, 2014). 

 Bruce Power does have exceptions to these regulations as it has conducted 

sufficient site-specific research and have been able to prove to the MOE that the lower 

standards do not have negative effects on the environment. The current Certificate of 
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Approval stipulates that during the “summer” period which is from the 15th of April to 

the 14th of December, the output water cannot exceed 11.1°C above ambient at Bruce A 

and 11.0°C at Bruce B. During the “winter” period which is from the 15th of December to 

the 14th of April, this output temperature increases to 13.0°C for both reactors. The 

certificate also increased the TMAX threshold from 30.0°C to 32.2°C for Bruce A and does 

not stipulate a value for Bruce B. A summary of this information is available in Table 1.1. 

As mentioned previously in the PWQO, Bruce Power must also conduct ecological 

monitoring of the area surrounding their facility to ensure they do not have an excessively 

negative impact on the environment. To maintain this operating increase, Bruce Power 

must constantly monitor outflow temperatures at the discharge points to ensure they do 

not breach these levels. Should Bruce Power near some of these temperature values, they 

must proactively de-rate their reactors to reduce the temperature of the water leaving the 

condenser and thus reduce the discharge temperature. De-rating a reactor is not a simple 

process to complete. There are multiple steps that need to be completed and in doing so, 

this reduces the overall output capacity of the Generating Station. By de-rating a reactor, 

one is effectively reducing how much power is available to the Province of Ontario. 
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Table 1.1 
Bruce Power Operating License Limits 
 

Parameter Calendar Period 

Bruce A 
Daily (24 Hour) 

Avg. Temperature 
Limit 

Bruce B 
Daily (24 Hour) 

Avg. Temperature 
Limit 

Temperature 
Difference (Effluent 
minus Intake) 
 

Dec 15 to Apr 14 
Apr 15 to Dec 14 

13.0°C 
11.1°C 

13.0°C 
11.1°C 

Effluent 
Temperature Max Year-Round 32.2°C 32.2°C 

Source:  Bruce Power Certificate of Approval 
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1.4 – Monitoring Efforts 

 As it has been previously stated, Bruce Power is bound by regulation to ensure 

they monitor a variety of environmental parameters to ensure they conform to the 

licensing terms set out by regulators. With regards to thermal effluent, Bruce Power has 

three main initiatives they must fulfill. Primarily, they must maintain monitoring stations 

that provide baseline ambient temperatures to each operating unit so that discharge 

thresholds can be set. Secondly, the facility must monitor discharge at each discharge 

channel to ensure they do not exceed output temperatures. Lastly, as mandated by the 

Certificate of Approval, Bruce Power must monitor fish kill, fish stress and investigate 

the effect of their effluent on benthic, plankton, macrophyte and fish communities (MOE, 

2006). More specifically, Bruce Power must monitor smallmouth bass nesting habits, 

dissolved gases around the Bruce A discharge and the water temperature at the substrate 

(Golder, 2007). 

 Ambient temperatures are collected by two off site stations north and south of the 

generating station. Bruce A receives it readings from a site 6.5 km north of the Bruce A 

discharge along the shoreline of Lake Huron near Concession Road 12 (Bruce Township) 

(Golder, 2005). Bruce B receives its ambient temperature from a site 5.5 km south of the 

Bruce B discharge channel near McRae Point (Golder, 2005). It is from these sites that 

the governing temperature is established. Discharge temperatures are derived from 

specific points near the mouth of both discharge channels. The current method employs 

single point thermal couples to report the data. Measuring ecological stress is a little more 

complex and the programs established for this method are beyond the scope of this 

research study. As an aside, these monitoring programs are developed and subsequently 

approved by the MOE prior to implementation.  

 Beyond what is required by the Certificate of Approval, Bruce Power has taken it 

upon themselves to drive innovation by constantly examining newer methods to monitor 

the facilities thermal effluent. For instance, in 2013 a team from Queen’s University led a 

co-operative study examining what technologies and techniques could be used to enhance 

thermal effluent monitoring (Queen’s University, 2013). Within the study, satellites, 

Unmanned Aerial Vehicles (UAV) (both rotary and fixed wing), stationary cameras and 
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ground-based probes were evaluated. From the study it was evident that satellite 

technology was negated as impractical for regulatory purposes. The main concern for 

satellite-based solutions was the poor scaling of the spatial resolution and the lack of 

frequency in the data capture. Stationary solutions were seen as favourable when trying to 

capture a small area, but there was a general concern that a tower mounted sensor would 

be unable to image the entire extent of the plume from a fixed location. UAVs also 

seemed appealing to the research group, but similar to the ground-based solution, it was 

believed that at the time the technology would be unable to capture the extents of the 

plume in a single deployment. The group did elude to the fact that this technology was 

developing quickly and therefore there was great potential in the future to revisiting this 

solution. The project team concluded that for regulatory purposes the best solution would 

have to be ground based and the remainder of the study focused on methods and 

technologies that could be utilized to enhance current practices. It is believed that fixed 

wing aerial solutions were not examined at the time of the study as it was not conceived 

to be a viable option that was available. 

1.5 – Statement of Research Objectives 

The purpose of this study is to evaluate the potential of aerial thermal data 

acquisition, using ground based and satellite-based data as a means to compare and 

contrast the abilities of the airborne technology. A comprehensive comparison will be 

conducted between the FireMapper 2.0 thermal platform and surface-based temperature 

sensors. A second comparison will be completed between the FireMapper 2.0 thermal 

platform and Landsat 8 TIRS. FireMapper 2.0 data will also be compared to computer 

generated models to test the predictive nature of these computational models. The goal of 

this comparison is to learn about the strengths and weaknesses of each thermal collection 

method as this is of interest to Bruce Power. Furthermore, this study is meant to assess 

whether aerial thermal technology would be a successful means of data collection that 

could be augmented into the regulatory realm. Current regulatory practices do not 

normally access thermal imagery for monitoring as this is still considered to be a new 

unproven method. Methods employed in this study were developed with speed of 

delivery as the priority. This study will attempt to maintain a technology agnostic stance, 

placing no preference on any one type of technology. With that statement in mind, only 
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certain datasets existed for this study and therefore evaluations were based on the 

available data. It is believed that this study will uncover that aerial data collection will 

assist in providing a new dimension of data. Satellites will always be successful in 

providing “big picture” results and surface-based probes will be successful in providing 

accurate and accessible point data. Aerial technology will assist in bridging the gap in 

spatial resolutions. Furthermore, the Bruce Power facility will provide an excellent study 

site for framing this analysis as it provides vast controlled thermal contrasts within a 

small study area. 
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2.0 – Literature Review 

 The benefits to measuring thermal effluence and understanding the extends of 

plumes is an invaluable tool for regulators and researchers. The 1980s saw the most 

notable leap forward in numeric modelling as computers became more common place 

(Hamrick and Mills, 2000). Studies have indicated that warm water does impact the 

various organisms that exists within the path of effluent; there are numerous ecological 

studies that have been conducted to understand the effects of warm water on the 

development of native species and the alterations to the balance of the ecosystem 

(Poornima, et al., 2003; Hillyard and Keeley, 2012; Ingleton and McMinn, 2012). These 

studies tend to focus on the effects of temperature changes on a specific organism, but 

little focus is placed on the spatial variability of the thermal effluent. This is mainly due 

to the fact that spatially modelling of a large discharge area is not an easy or cost-

effective task. Thermal technology has been around for a century in many different 

forms. Initial variants of this technology were capable of providing still frame data of an 

area. In contrast, this technology has developed significantly to date, with the ability now 

to collect video in multiple bands of the thermal spectrum that is radiometrically 

calibrated. One of the largest limiting factors to the commercial development of thermal 

imaging technology has been access to budgets as this technology is typically costly to 

build and operate. Thankfully, as imaging satellites became more commercialized, this 

provided access to new datasets that could provide “cost-effective” thermal data 

(Gibbons, et al., 1989).  

The science behind modelling water properties and mixing zone interactions can 

be traced back to the early 1970s. Researchers Silberman and Stefan conducted a study to 

highlight the critical parameters that influence modelling thermal plumes. They denoted 

that effluent characteristics, outlet characteristics, flow dynamics, stratification, water 

geometry, wind, atmospheric temperature and solar radiation need to be considered when 

generating a sound thermal model. This research generated the framework for 

computational models today. For instance, a site study of the Bruce Power complex was 

conducted in 2005 by Golder and Associates. During the planning phase, it was decided 

that the Cornell Mixing Zone Expert System (CORMIX) model would be the best 
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computational model to represent the Lake Huron shoreline. The CORMIX model is a 

series of software modules that generate a variety of hydraulic calculations. The 

CORMIX model was developed by a consortium of interest groups that were interested in 

furthering the modelling and understanding of simple mixing zones (Schreiner, et al., 

2002). The strength of the CORMIX model is the ability to model simple, single point 

discharge mixing zones (Roberts and Tian, 2003). Although CORMIX is held in high 

regard for being a robust model, in a comparative study of a similar costal environment it 

was determined that the CORMIX model underperformed in comparison to other model 

options (Roberts and Tian, 2003). It was suggested that the CORMIX model 

overestimated dilution and rise height in comparison to the RSB and UM3 models 

(Roberts and Tian, 2003). 

 Historically, thermal profiles in coastal environments were typically surveyed 

utilizing ground resources (stationary buoys or chartered boats with point sampling 

equipment). These point samples were then placed into modelling software to extrapolate 

results and provide a visual representation of the findings (Gibbons, et al., 1989). These 

techniques have since advanced with the advent of cellphones and other low-cost data 

transmission technology. Although the method of collection remains the same, the ability 

to retrieve the data has increased substantially. Some research has been conducted to 

evaluate the feasibility of utilizing airborne and satellite-based sensors, but these have 

mainly been literature-based reviews or small-scale experiments to provide a basic proof 

of concept for a larger study area. The first study that was completed that seemed to 

assess the utility of the thermal band on the Landsat 5 TM sensor was completed by a 

cooperative initiative between the Pacific Gas and Electric (PG&E) Company and the 

U.S. Department of Energy’s Pacific Northwest Laboratory in 1989. In this study, the 

group compared a single scene of Landsat 5 TM data with ground sampled data that was 

collected within a couple of hours of the satellite acquisition. The group determined that 

the calculated satellite temperature was within 0.6°C of ground sampled data. 

Furthermore, they discovered that other groups were able to correlate satellite 

temperatures to be within 1-2°C of ground samples. The research team were also able to 

determine that plume size was a result of tidal flow, power output and prevailing winds. 

They also determined that although of the thermal band on the Landsat 5 TM sensor was 
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relatively coarse in the thermal band (120-meter by 120-meter pixel resolution), the data 

was sufficient enough to establish the extents of the thermal plume generated by the 

power station. One critical benefit to satellite-based data is the ability to accurately 

position the dataset with a high degree of accuracy. Furthermore, satellite budgets are 

typically larger in comparison to other methods of capture which allows for the 

installation of higher end navigation solutions.  

In 2003, a research group in Guangzhou, China essentially repeated the 

aforementioned study by using Landsat 5 TM data to generate a thermal map of effluence 

generated by a nuclear power generating facility in Daya Bay in the South Chinese Sea 

(Chen, Shi and Mao, 2003). In this study, the group accessed 7 scenes of Landsat 5 TM 

imagery from 1986 to 2001 and used ground sampled data to verify the accuracy of the 

Landsat 5 TM data. Due to the temporal range of the dataset, the group was able to access 

two datasets that captured the thermal stratification of the environment prior to the 

generating stations becoming operational. The group determined that the Landsat 5 TM 

data was sufficient to model the thermal regime within the Daya Bay but did allude to the 

fact that satellite data is highly dependent on atmospheric changes. From the literature 

review completed by this group, they determined that some studies exhibited temperature 

variances of 6-8 Kelvin between Landsat 5 TM data and ground sampled data. 

Research has been completed in Kalpakkam, India on the extent of thermal 

effluence on the local waterway using surface water transects (Anupkumar, et al., 2005). 

Between 2000 and 2002, a research group from the Water & Steam Chemistry 

Laboratory in Kalpakkam, India chartered a boat to collect 15 data sets on the water 

temperature surrounding the Madras Atomic Power Stations. The research group was 

quick to denote that India is well behind environmental monitoring and establishing 

regulations to keep industry accountable (Anupkumar, et al., 2005). The results of these 

surface collections were then plotted into 3D plotting software, Surfer™. The results of 

the analysis were positive as the group was capable of delineating some of the plume 

extents using mathematical models derived from surface samples. The group did 

conclude that some of their surveys did not encompass the entire area of the thermal 

effluence and that a larger survey area would be required to incorporate all tidal, wind 
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and current conditions. It is believed that an airborne or satellite-based solution would 

have provided significant depth on what the group was attempting to accomplish. 

 A recent study conducted by a group in Colorado in 2016 has attempted to further 

the investigation of utilizing UAVs and micro scale thermal cameras to monitor thermal 

effluent of a power facility in Wellington, Colorado (DeMario, et al., 2017). In addition 

to employing a thermal camera, the group also integrated a tethered thermocouple to the 

base of the UAV to allow it to collect instantaneous temperature data that could be 

compared to the remote sensed thermal data. The results of the study highlighted the 

current limitation of UAV technology. The group indicated one of the key limitations of 

this technology was the heavy reliance on power and therefore the operating time of the 

research asset was limited. As a result, the platform had difficulty hovering overhead the 

discharge channel for prolonged periods of time which limited data capture. There were 

also significant limitations within the remotely sensed data. For instance, the thermal 

camera operated separately from the Global Positioning System (GPS) and integrating the 

data became difficult. As a result, georeferencing was problematic. In addition, the 

thermal data acquired was automatically scaled within the control software to maximize 

the colour pallet based on the maximum and minimum temperature within the 

instantaneous scene. This function could not be disabled which limited some of the post 

flight data analysis. It was inferred that other cameras do exist on the market that allow 

greater control over the captured data. It was further discovered during post processing 

that good GPS data is as critical as the thermal data when attempting to generate a 

rectified representation of the ground. Ultimately the group resorted to assembling the 

thermal frames in Photoshop to generate a homogeneous image of the study site. The 

difficulties experienced in this study could be easily related to aerial platforms as capture 

and processing techniques would similar; the most predominant difference would be the 

scale of the area captured. 

One recent study did successfully mosaic 6,000 Thermal Infrared (TIR) frames of 

a geothermal area in New Zealand using a drone and an ICI 640 × 480 Thermal Sensor 

(Harvey, Rowland and Luketina, 2016). The group elected to use Agisoft Photoscan® 

software to generate the mosaic with good success. It is believed that if this success was 
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possible for a drone-based unit over land, it would be possible to achieve similar success 

using an airborne sensor over water. Further assessments would have to be conducted to 

validate this hypothesis. One principal that was underestimated at the start of this project 

and diminishes the ability to reprocess older data is the percentage of side lap used during 

data acquisition. For optimal results using newer techniques a minimum side lap value of 

50% is required with 60% being the favoured amount. Flights for this study were 

conducted with 40% overlap with a 10% tolerance for error. Therefore, in some instances 

the data had only 30% overlap. Water also increases the difficulty of these processes as it 

is a liquid and is ever changing visually. Agisoft Photoscan® and other similar software 

suites are highly reliant on fixed control points within a scene to generate accurate 

mathematical models in which mosaics are generated upon. Images of water change in 

texture from scene to scene and therefore mathematical solutions cannot typically be 

generated off this form of processing as it is very difficult to assign accurate control 

points between two or more images.  

Thermal technology has been in existence for nearly a century with much of the 

initial development driven by World War II. Initial development was based off two 

different principals which catered to two different needs: one sensor was developed to 

scan while the second sensor was designed to stare (Rogalski, 2011). First generation 

thermal sensors were complex systems that generated significant amounts of heat to 

record thermal data. As such, large and complex cryogenic cooling systems were required 

to stabilize the TIR sensor technology. The data collected was crude, greyscale and 

required skilled interpreters to analyze datasets and provide a meaningful understanding 

of the results. These units were mainly capable of providing raw imagery, and the thought 

of marrying this technology with coordinates and bearings was not seen as feasible at the 

time. Systems were large and cumbersome and could only be afforded by government 

and military agencies with large budgets as the aircraft required for this sensor suite were 

equally large. It was not until the discovery of microbolometer technology that sparked 

the move into the third generation of development that removed the need for massive 

coolers, reduced the cost of the sensor and allowed for this technology to be available to 

the commercial industry (Hoffman, et al., 2005). At the start of the third generation, TIR 
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sensors were capable of capturing data and generating individual scenes with multicolour 

functionality (Rogalski, 2011). 

As thermal sensors become smaller and more capable, more emphasis is also 

placed on how to integrate the imaging technology with other systems to provide more 

depth to the data. For instance, increasing the frame rate, changing the spectral range or 

coordinating the data with high quality GPS data increases the utility of the technology. 

Unfortunately, it seems that regardless of how much development is done on sensor 

capabilities, there are still many inherent principals that cannot be overcome. For 

instance, thermal image acquisition over water is a complex process to master as water 

itself contains a variety of properties that are very difficult to control and has adverse 

effects on the resulting data captured (Wolfe and Zissis, 1985). Changes in sun angle, 

cloud condition and wind are a few principals that need to be factored for when acquiring 

data. Since thermal sensors are incapable of differentiating between reflected and emitted 

thermal radiation, the resulting data is a combination of both (Torgersen, et al., 2001). 

This is further complicated by the fact that with the presence of waves, it is quite possible 

that water could be reflecting values that are meters away from the specific target. To 

combat this potential influence, one can coarsen the pixel resolution and take the image at 

a higher altitude to diminish some of the lower altitude influences. This can be an 

effective solution if coarser data is acceptable to the application. 

Acquiring thermal data of water does pose many significant challenges. It has 

been suggested in some studies that daytime thermal imagery of water-based targets can 

be greatly influenced by cloud cover and sun angle as these changes the reflectivity of the 

thermal radiation (Torgersen, et al., 2001; Wolfe and Zissis, 1985; Sidran, 1985). As a 

result, it has been highly suggested that meaningful TIR data should be captured in 

nighttime conditions to ensure it removes the generation of false positives (Neale, et al., 

2016). It has been denoted in some literature (Torgersen, et al., 2001) that cloud does 

alter the emissivity of the ground and therefore scans should only be completed with clear 

sky conditions. By doing so, this removes the potential for cloud to alter the solar 

influence on the ground and provide a better representation of the ground cover. 
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3.0 - Methodology 

3.1 – Study Site 

 Bruce Power nuclear generating complex is located on the shores of Lake Huron, 

north of Kincardine, Ontario, Canada (44° 19.63’ N, 81° 35.44’ W). Bruce Power is a 

privately-owned corporation that provides 30% of the energy required in the Province of 

Ontario to the Ontario Government. The Bruce Power complex is made up of two distinct 

reactors: Bruce A and Bruce B. Bruce A is located at 44° 20.17’ N, 81° 33.80’ W which 

is on the north shore of the entire complex. The reactors in this complex discharge water 

into a shallower portion of Lake Huron and is known locally as Baie Du Doré. The Bruce 

B reactor is located on the south part of the Bruce Power complex at 44° 19.12’ N, 81° 

36.18’ W. Bruce B discharges water in to a deeper portion of Lake Huron. Figure 3.1 

illustrates minimal bounds of the study area which accounts for roughly 88.7 km2 of Lake 

Huron. Figure 3.2 illustrates the elevation and bathymetry of the Bruce Power complex. 

This study does focus on assessing the viability of collected airborne data and therefore a 

study area was predefined prior to initial collection in 2013.  

3.2 – Data Collection 

3.2.1 – Surface Based Temperature Data 

Surface based data was collected and made available to the North Ontario School 

of Medicine during the study period. The Bruce Power Environmental Monitoring team 

led the collection of this data using submersible temperature probes that were connected 

to dataloggers. This form of data collection was not specifically tied to this research 

project and therefore the geographic bounds of the deployment area were unknown when 

initial planning began for the aerial scanning campaign. In addition, dataloggers were 

placed at various depths to collect multi point data for a variety of other monitoring 

programs. The dataloggers were programmed to capture instantaneous temperature data 

every 15 minutes. For the purpose of this study, only dataloggers that had a reported 

depth of 1 meter or less were utilized to validate surface water temperature. Figure 3.3 

delineates the location of the surface water dataloggers in relation to the Bruce Power 

Generating Facility. 
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Figure 3.1 

Illustration of Bruce Power Generating Facility on Lake Huron near Kincardine, Ontario. 
The study area bounds encompass roughly 88.7 km2 of lake and shoreline. Ambient probe 
sites are North and South of the study area. 
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Figure 3.2 

Illustration of the elevation and bathymetry of the study site. This data is a fusion of 
SRTM 3-arc second data and NOAA Lake Huron Bathymetry generated on October 2nd, 
2006. 
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Figure 3.3 

Bruce Power surface water temperature probe location. Each point represents a battery-
operated temperature probe with data logging abilities. Temperatures were sampled every 
15 minutes, perpetually. Probes were tethered to anchors and suspended near surface 
(within 1 meter of the surface) to collect temperature data. 
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3.2.2 – Satellite Based Thermal Data 

 Landsat 8 was launched on 11 February 2011 with the purpose of collecting high 

resolution imagery of the globe in a timely manner (USGS, 2016). The satellite was 

equipped with two push-broom instruments: The Operational Land Imager (OLI) and the 

Thermal Infrared Sensor (TIRS), which essentially capture data of the entire globe every 

16 days (USGS, 2016). The benefit to Landsat 8 data for this study was the ability to 

access TIRS data in the 10.6 – 11.19 microns band (Band 10) and the 11.5 – 12.51 

microns band (Band 11). Furthermore, this multiband data allows for quick reference 

between the visual and thermal bands of the electromagnetic spectrum. 

 A search was conducted post airborne data acquisition to find a Landsat 8 TIRS 

tile that was captured during one of the airborne thermal scans. It was discovered that 

there was a Landsat 8 TIRS image acquired on 6 May 2014 that coincided with airborne 

acquisition. The tile had sufficient coverage of the study area, was cloud free and was 

captured at 16:09 Zulu which was 9 minutes after the airborne scan was completed. TIR 

data from 10.6 – 11.19 microns (Band 10) and 11.5 – 12.51 microns (Band 11) were 

acquired at 100-meter resolution but were resampled before the product was posted to 30-

meter resolution. For the purpose of this project, data from 10.6 – 11.19 microns (Band 

10) was utilized as the prime thermal band for analysis as recommended by the Landsat 8 

(L8) Data Users Handbook (USGS, 2016). 

 TIRS data captured by Landsat 8 is initially stored as a 16-bit Digital Number 

(DN) and needs to be corrected for Top Of Atmosphere (TOA) Radiance. To convert the 

raw data to TOA Radiance, equation 1 was utilized as suggested by the Landsat 8 (L8) 

Data Users Handbook (USGS, 2016): 

𝐿𝜆 =  𝑀𝐿𝑄𝑐𝑎𝑙 + 𝐴𝐿      (1) 

Where Lλ is TOA spectral radiance, ML is the band-specific multiplicative 

rescaling factor, Qcal is the quantized and calibrated standard product pixel values and AL 

is the band-specific additive rescaling factor. 
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The values calculated in the TOA Radiance were then converted to temperature K 

using the Conversion to At-Satellite Brightness Temperature equation as suggested by the 

Landsat 8 (L8) Data Users Handbook (USGS, 2016): 

𝑇 =
𝑘2

𝑙𝑛(
𝑘1
𝐿𝜆

+1)
      (2) 

 Where T is the at-satellite brightness temperature (Kelvin) and K1 and K2 are both 

band-specific thermal conversion constants located in the metadata of the acquired scene. 

Temperature values were then converted from Kelvin to degrees Celsius for further 

analysis.  

3.2.3 – Airborne Thermal Data 

 An airborne thermal data collection campaign was initiated on 26 February 2013 

and was completed on 6 August 2015. Over this time period, 19 airborne thermal scans 

were completed over the Bruce Power Generating complex. The purpose of these scans 

was to collect thermal data during the summer and winter months in varying wind 

conditions. From the literature review, it is evident that thermal sensor data is the least 

influenced during night time conditions (Lippitt, Stow and Riggan, 2016; Harvey, 

Rowland and Luketina, 2016); but an executive decision was made that it was more 

critical to capture the plume extents during “peak” operational conditions and therefore it 

was decided that flights would only be conducted during the day. A study was completed 

using the FireMapper 2.0 during daytime conditions and the results were favourable with 

minimal impact to the data (Hillyard and Keeley, 2012). For flights to dispatch, visibility 

in the study area needed to be greater than 6 statute miles and the cloud base had to be 

higher than 3,000’ Above Ground Level (AGL).  

 For airborne thermal data collection, the FireMapper 2.0 thermal sensor built by 

Space Instruments in San Diego, California was utilized. The FireMapper 2.0 utilizes 

uncooled microbolometer technology to collect accurate thermal data in the 8.0 – 12.5 

micrometer range. The FireMapper 2.0 has a 44.7° Cross Track FOV and has a 

temperature resolution of 0.01°C. The sensor was capable of capturing thermal data in a 
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320 by 240-pixel format. The sensor was operated in “Tactical Mode” during these 

airborne missions which allowed for a capture rate of 6 frames per second. Data was 

captured in a 16-bit raw format. Of the 19 scans completed, 18 were flown at 2,500’ AGL 

to capture a pixel resolution of 2 meters with a swath width of 625 meters. The last 

thermal scan completed in 2015 was flown at 6,500’ AGL to capture a pixel resolution of 

5 meters with a swath width of 1,625 meters. 

Airborne acquisition was conducted in a Cessna 337 Skymaster. The Skymaster 

was flown at approximately 140 knots and had a flight endurance time of 6 hours. 

Thermal scans were only flown if the entire area could be captured in one entire flight. 

Guidance was provided through the AgNav Guia guidance system which would store 

historical flight plans to allow the same area to be captured at the exact same position. 

The Guia was programmed to allow for collection with 30% side overlap with a tolerance 

of 5%. Passes were flown sequentially and bidirectionally to ensure proper overlap and 

temperature representation. Figure 3.4 provides a visual representation of how data was 

collected on 6 August 2015.  

 In addition to the collection of thermal data, an Inertial Navigation System (INS) 

was integrated inline to collect accurate Global Navigation Satellite System (GNSS) data. 

A NovAtel Span CPT unit was incorporated that allowed for the collection of 1.5-meter 

accurate GPS data. The INS was initialized 15 minutes prior to the collection of thermal 

data and disconnected 15 minutes post capture. The GNSS data was collected on a 

separate Secure Digital (SD) card and processed using NovAtel Inertial Explorer® 8.5 

software. Inertial Explorer had the ability to process the raw GPS signal using static 

boresight offsets or could also access a more dynamic Precise Point Positioning (PPP) 

data process to enhance the accuracy of the collected GPS signal. Using the static 

method, calculated GPS data is only based off the inputs provided by the INS receiver 

and the boresight offsets provided by the vendor on an annual basis. In the dynamic PPP 

method, calculated GPS data is based off the inputs received by the INS receiver, 

boresight offsets provided by the vendor and a set of correction values that are 

downloaded from the GNSS constellation after flight that provide finite orbital 
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corrections. For the purpose of this study, the static method was utilized to assess and 

validate the systems unenhanced accuracy.  

 Captured thermal data was stored on portable hard drives within the aircraft. Both 

thermal and Exterior Orientation (EO) data required post processing to generate useable 

Geographic Information System (GIS) ready data. Before the thermal data could be 

processed into a mosaic, the raw GNSS data needed to be processed into a useable 

format. Within this process, the positional data was converted into the North American 

Datum 1983 (NAD83) datum and projected into the Universal Transverse Mercator 

(UTM) zone 17. A Standard Operating Procedure (SOP) was generated prior to the first 

mission to ensure that all input settings would remain the same for each sequential data 

capture. A copy of the SOP is provided in Appendix Q. As a result of the post processing 

in Inertial Explorer, an EO file was generated providing date, time, latitude, longitude, 

aircraft altitude, omega, phi and kappa data for each captured frame. Signal quality 

reports were also generated to assist in the quality assurance process. The output from 

this stage would then be utilized to allow for the geolocation of the captured thermal data. 

A proprietary script was generated by PCI Geomatics of Markham, Ontario that 

allowed for the merger of thermal and EO data. The PCI workflow was automated and 

had minimal inputs from the user. Initial processing would generate the required file 

structure for the workflow and these extensions would then be populated with the raw 

data from the aircraft sensor. Input parameters would be set in the command line which 

included the project name, the anticipated overlap of the captured passes, the requested 

temperature threshold of the data and the requested map projection and datum for the 

output product. The workflow would then decode the raw data, generate orthorectified 

tiles based on referenced Digital Elevation Model (DEM) and then generate an 

orthomosaic. The mosaic was generated solely based on GNSS data in the EO file. The 

result of this workflow was a 32-bit orthomosaic, an 8-bit Georeferenced TIFF 

(GeoTIFF) and a shapefile rendering of the project area. The pix file was then used for 

further analysis as the bit size allowed for a more accurate representation of temperature 

values in the raster layer.  
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Figure 3.4 

Sample flight lines flown over Bruce Power on 6 August 2015. Lines were flown 
sequentially from off shore to on shore and bidirectionally between passes. 
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3.3 – Data Analysis 

3.3.1 – Comparing FireMapper 2.0 with Surface Sampled Data 

 Surface water sampled data was collected by Bruce Power using water borne 

temperature probes attached to dataloggers. This temperature data along with locational 

data was provided by Bruce Power for each airborne scan that were completed between 

2013 and 2015 and the location of these probes is illustrated in Figure 3.3. After 

reviewing the location of each temperature probe, it was evident that most of the surface 

temperature collection points were beyond the study area. To maximize the value of this 

data, it was decided that only aerial scans that contained most of these data points should 

be utilized in surface temperature validation. Unfortunately, there was only one scan 

completed on 8 August 2015 that contained all the surface temperature probes. It was 

decided that this one scan would be utilized to compare the temperature data collected 

aerially with actual surface water temperatures.  

 To compare both datasets, the point data needed to be conditioned. The 

dataloggers were initially programmed to capture temperature data every 15 minutes. Due 

to the nature of airborne data collection, the entire scan area could not be collected in one 

pass and therefore 2 hours were required to capture the necessary data. To reflect this 

temporal difference, the datalogger temperatures were averaged over the aerial 

acquisition time span. The difference in temperature change was also recorded for each 

probe. The point shapefile was then overlaid on the thermal raster dataset. Using ArcGIS, 

thermal raster values for specific points were extracted and attached to the attribute table 

of the point data shapefile. Initially it was anticipated that the underlying raster data could 

be correlated to a specific capture time, which would remove some of the uncertainty 

introduced by time. Unfortunately, through the mosaic generation process it is difficult to 

determine what portions of specific frames were utilized. Hence, specific times could not 

be calculated. To provide some context, bundle IDs for the dataloggers were arranged in 

chronology of capture. This was possible as the order and direction of flight passes was 

known. 
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3.3.2 – Comparing FireMapper 2.0 Data with Landsat 8 TIRS Data 

 A search for applicable Landsat 8 TIRS data was completed at the end of the 

aerial acquisition campaign. It was determined that one Landsat 8 TIRS acquisition did 

coincide with airborne completed on 6 May 2014. The primary purpose of this analysis 

was to compare temperature data from a relatively new platform (FireMapper 2.0) to 

temperature data collected from a platform that has been researched significantly in the 

past with known attributes (Landsat 8 TIRS). This analysis would also assist is 

determining the spatial accuracy of the FireMapper 2.0 platform as the location of the 

temperature data was equally as important as the temperature values themselves. Since 

this study was mainly concerned with the temperature of water, a study area was 

generated that only encompassed areas with water. Figure 3.4 illustrates the bounds of the 

sample area. The study area had significant temperature changes in a small area and 

therefore one hundred samples points were then utilized as a means of comparing the 

spatial accuracy of both data sets. This was accomplished utilizing the “Create Random 

Points” tool in ArcGIS. Raster values from both datasets were then attached to the point 

layer for further analysis. 

 FireMapper 2.0 data was collected over a 2-hour span and therefore there was 

variability within the resulting raster data set; whereas, data collected by Landsat 8 TIRS 

was collected instantaneously in a single image. Sample points were ordered in capture 

chronology as it was not possible to determine the exact time FireMapper 2.0 data was 

collected for each sample point. This would allow for some ability to analyze temperature 

change over time.  

 To further assess the spatial sensitivity of both sensors, a linear transect was 

drawn from a point offshore to a point nearshore around Bruce A. An illustration of this 

transect is provided in Figure 3.5. The goal of the transect was to address an area within 

the datasets that had high temperature variability within a short distance. This line was 

then segregated into 50 equal intervals that would be used to capture additional point 

temperatures from the Landsat 8 TIRS and FireMapper 2.0 datasets. These points were 

autogenerated using an ArcGIS extension and were 87.5 meters apart.  
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Figure 3.5 

Random sample sites for comparison of Landsat 8 TIRS and FireMapper 2.0 data. 
Random points were generated using “Create Random Points” function in ESRI ArcGIS 
10.3.  
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Figure 3.6 

Illustration of the linear transect location. The plume transect will provide a means to 
gauge the sensitivity of each sensor by modelling the cross-section profile of surface 
temperatures.  
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3.3.3 – Comparing FireMapper 2.0 Data with Modelled Data 

 Thermal scans were analyzed and vetted prior to using the data. Although 19 

scans were completed, not all were utilized within this study. The first stage of 

assessment was the quality of the GNSS data. Signal quality reports were examined and 

datasets that displayed significant noise or gaps within the signal were rejected. In some 

instances, a solid GNSS solution was lost when the aircraft was banked to reposition for 

the next pass. The second phase of vetting was based on the quality of the mosaic. Data 

sets that displayed excessive positional errors were eliminated from this assessment. The 

final phase was examining the visual quality of the data. In some instances, the thermal 

camera did not correctly calibrate between passes which led to a temperature offset 

between passes. Data sets with more than one uncalibrated pass were removed from 

further analysis. As a result of the vetting process, only 13 of the 19 aerial thermal scans 

were utilized within this project. 

 To generate consistency, a study area boundary was established and is illustrated 

by Figure 3.1. A GIS reference layer was accessed and utilized as the baseline for further 

analysis. The Southern Ontario Lakes Layer is generated by the Province of Ontario and 

is available free online. The layer is delineated from high resolution orthophoto 

interpretation completed under contract by the Ontario Government. A clip layer of the 

study area was generated by removing the land features from the study area box. This 

newly generated clip layer would be used to clip each thermal dataset. 

 Unfortunately for this study it was not possible to access the published control 

temperature data from Bruce Power and therefore another means of assessment had to be 

developed. Prior to the study it was theorized that ambient temperatures could be 

extrapolated from airborne scans using the same geographic points used by Bruce Power. 

This proved to be problematic as shore-based temperatures can be influenced by day time 

heating, the depth of the water column and natural circulation patterns of the surrounding 

water. There was added concern that trusting the spatial accuracy of data without a 

published Root-Mean-Square Error (RMSE) or surveyed Ground Control Point (GCPs) 

for reference would diminish the accuracy of this assessment. It was therefore decided 
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that a good estimate of ambient surface temperature should be collected using an offshore 

site. To select an offshore site, the foot print of all 13 scans were populated in ArcGIS. 

Each scan was analyzed to identify areas that seems to have the least influence from the 

plume and any other shallow features that could influence the ambient temperature. A 

point was manually assigned for each scan and then compiled to assist in selecting a 

location. After careful consideration, it was decided that the ambient sample point would 

be located at 44° 20.97’ N, 81° 37.89’ W. All scans were then reviewed to ensure that the 

selected point had little to no external influence from other visible thermal regimes. 

Using single point temperatures for ambient control of a dataset was seen as a 

flawed strategy. At face value, the FireMapper 2.0 datasets lacked homogeneity within 

the mosaics and therefore, it was decided that a 1-hectare buffer would be applied to the 

selected ambient point. Data within this buffer was then averaged to generate the 

governing ambient temperature for further analysis. Before collecting this data and 

assigning an average ambient temperature for each scan, the buffer was reviewed in each 

scan to ensure that there were no thermal abnormalities within the control area. 

 Since the 13 scans used were acquired in both the summer and the winter, 

different regulations applied to the output thresholds. For the purpose of this study, all 

scans would be categorized in 2°C intervals up to 10°C above ambient. Any values above 

10°C would then be analyzed on a case to case basis. Attribute tables were built for the 

raster datasets and the area of each interval for each scan was tabulated. The area 

calculation only provided spatial information for that specific 2°C interval. Although, if a 

segment was 4°C above ambient, it was also 2°C above ambient; therefore, higher order 

segments were added to lower order categories to generate an aggregate area. For 

instance, 2°C data encompassed areas that were 4°C, 6°C, 8°C and 10°C above ambient. 

By tabulating the temperature divisions in this method, it would allow for the comparison 

of airborne thermal data with the calculated model presented by Golder and Associates. 

The tabulated area values were then converted to represent the percentage of the study 

area that was occupied by that temperature segment above ambient. 
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4.0 - Results 
 

4.1 – Comparing FireMapper 2.0 Data with Surface Sampled Data 

 Figure 4.1 illustrates the difference between the surface water temperature probe 

data provided by Bruce Power and the data acquired by FireMapper 2.0 on 6 August 

2015. Table 4.1 summarizes some of the statistics calculated for the data set. The average 

temperature for surface water probe data was 22.52°C; while the average temperature of 

the FireMapper 2.0 dataset was 17.98°C. This equates to an average difference of 4.54°C. 

The surface water temperature probe range was 8.09°C; whereas the range in the 

FireMapper 2.0 data was 4.50°C. The difference in the temperature range was 5.88°C. 

The correlation coefficient for calculated for both temperature profile. It was determined 

that the r value of this regression was 0.83 with an r2 value of 0.69. An unpaired t-test 

was conducted since only two groups were being compared and the samples utilized were 

not identical. The t-stat was larger than t-critical and therefore the null hypothesis was 

rejected.  
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Figure 4.1 

Comparison of surface water temperature probe data and FireMapper 2.0 data collected 
on 6 August 2015. The x-axis represents the surface water temperature probe ID in 
sequence of acquisition. The y-axis is temperature in degrees Celsius. The red line 
represents the temperature value extracted from the FireMapper 2.0 dataset. The blue line 
represents the surface water temperature probe value. 
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Table 4.1 
Summary of surface water temperature probe and FireMapper 2.0 statistics 
 
 Surface Probe FireMapper 2.0 Difference 
Average Temperature 22.52°C 17.98°C 4.54°C 
Standard Deviation 1.73°C 1.16°C 1.01°C 
Variance 3.01°C 1.34°C  
Maximum Temperature 26.70°C 20.50°C 6.20°C 
Minimum Temperature 18.61°C 16.00°C 0.32°C 
Range 8.09°C 4.50°C 5.88°C 
t Stat 13.0666   
t Critical (one-tail) 1.6669   
t Critical (two-tail) 1.9996   
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4.2 – Comparing FireMapper 2.0 Data with Landsat 8 TIRS Data 

 Figure 4.2 illustrates the relationship between temperature data collected by 

Landsat 8 TIRS and FireMapper 2.0. Both datasets were collected over Bruce Power on 6 

May 2014. Table 4.2 summarizes some of the statistics calculated for this dataset. The 

average temperature of the Landsat 8 TIRS sample points was 1.80°C; while the average 

temperature of the aerial scan was 2.36°C. The average difference of both datasets was -

0.56°C. The correlation coefficient for both temperature profiles was calculated. It was 

determined that the r value was 0.98 with an r2 value of 0.97. An unpaired t-test was 

conducted since only two groups were being compared and the samples utilized were not 

identical. The t-stat was smaller than t-critical and therefore the null hypothesis was 

accepted.  

 The Landsat 8 TIRS data was captured in a single scene and provided an 

instantaneous representation of the study area; whereas the thermal scan had to be 

completed over a 2-hour time span. As discussed previously, it is not currently possible to 

correlate a specific capture time to each individual sample point for the airborne data. The 

only means of comparing the effect of time was to place the sample point data in 

sequence of capture and assign a constant interval between each point. The difference in 

temperature was calculated for each point pair and plotted. A regression line was applied 

to judge the correlation in the difference in temperature. This is illustrated in Figure 4.3. 

 Figure 4.4 illustrates the relationship between temperature data collected from 

Landsat 8 TIRS and FireMapper 2.0 through the linear transect. Table 4.3 summarizes 

some of the statistics calculated for this dataset. The average difference of both datasets 

was 0.17°C. The correlation coefficient for both temperature profiles was calculated. It 

was determined that the r value of both datasets was 0.93 with an r2 value of 0.87. An 

unpaired t-test was conducted since only two groups were being compared and the 

samples utilized were not identical. The t-stat was larger than t-critical and therefore the 

null hypothesis was rejected.  
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Figure 4.2 

Comparison of Landsat 8 TIRS data and FireMapper 2.0 data collected on 6 May 2014. 
The x-axis represents the random sample ID in sequence of acquisition. The y-axis is 
temperature in degrees Celsius. The red line represents the temperature value extracted 
from the FireMapper 2.0 dataset. The blue line represents the Landsat 8 TIRS 
temperature value. 
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Table 4.2 
Summary of Landsat 8 TIRS and FireMapper 2.0 temperature statistics. 
 
 Landsat 8 TIRS FireMapper 2.0 Difference 
Average Temperature 1.80°C 2.36°C -0.56°C 
Standard Deviation 1.14°C 0.96°C 0.18°C 
Variance 1.67°C 1.27°C  
Maximum Temperature 5.67°C 5.90°C -0.23°C 
Minimum Temperature 0.29°C 1.00°C -0.71°C 
Range 5.38°C 4.90°C 0.48°C 
t Stat 1.6311   
t Critical (one-tail) 1.6672   
t Critical (two-tail) 1.9949   
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Figure 4.3 

Comparison of temperature differences found between FireMapper 2.0 and Landsat 8 
TIRS data acquired on 6 May 2014. The x-axis represents the random sample ID in 
sequence of acquisition. The y-axis represents the difference in temperature values in 
degrees Celsius. The dashed black line represents the calculated linear trend of the 
dataset. 
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Figure 4.4 

Linear cross section of thermal plume using Landsat 8 TIRS and FireMapper 2.0 data. 
The x-axis represents the sample point ID which were spaced 87.5 meters apart. The y-
axis represents the point temperature in degrees Celsius. The red line represents the 
FireMapper 2.0 values; whereas the blue line represents the Landsat 8 TIRS temperature 
value. 

  

0.0

1.0

2.0

3.0

4.0

5.0

6.0

7.0

8.0

9.0

10.0

1 3 5 7 9 11 13 15 17 19 21 23 25 27 29 31 33 35 37 39 41 43 45 47 49

Te
m

p
er

at
u

re
 (
°C

)

Point ID



41 
 

Table 4.3 
Summary of linear transect temperature statistics. 
 
 Landsat 8 TIRS FireMapper 2.0 Difference 
Average Temperature 5.99°C 5.82°C 0.17°C 
Standard Deviation 1.61°C 1.68°C 0.60°C 
Variance 3.01°C 1.34°C  
Maximum Temperature 8.62°C 8.40°C 2.02°C 
Minimum Temperature 2.88°C 1.90°C -1.36°C 
Range 5.73°C 6.50°C 3.38°C 
t Stat 13.0666   
t Critical (one-tail) 1.6669   
t Critical (two-tail) 1.9944   
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4.3 – Comparing FireMapper 2.0 Data with Modelled Data 

 Figure 4.5 illustrates the relationship between the 13 airborne scans captured 

using FireMapper 2.0 and the Golder and Associates model. The Golder model accounts 

for both summer and winter fluctuations. As well, it considers peak conditions and 

potential anomalies. It is also supposed to account for all possible wind conditions, 

current regimes and weather conditions. Figure 4.6 does illustrate the large variance in 

the 2°C segment, with significantly smaller variances in the warmer segments. There are 

no outliers in the 2°C segment, but there are outliers in the 4°C and above segment. 

Ultimately, the measured thermal plume by FireMapper 2.0 never exceeded the 

percentage values set by the CORMIX mode. 

 Figure 4.7 provides the same graphic for the 4°C temperatures. Similar to the 

results for 2°C, Figure 4.7 supports the fact that individually, the temperature area never 

exceeded the maximum set out by Golder and Associates. But spatially, the bounds are 

further than forecast. Within the 4°C data, there is some noise towards the western edge 

of the study area which can be attributed to poor sensor calibration.  

Figure 4.8 illustrates the extent of the 6°C plume. Similar to the 2°C and 4°C 

results, the 6°C data was also beyond the modelled Golder data. The data did show some 

noise towards the western extent. It is believed that some of the shore-based data towards 

the south can be considered “noise” due to daytime heating. The few linear streaks 

present throughout are due to poor camera calibration in some datasets. 

Figure 4.9 illustrates the extent of the 8°C plume. It is interesting to note that the 

Golder model did not suggest any signatures above 8°C around Bruce B; whereas, the 

scans revealed that there is some effluent in the main Bruce B channel. The thin band 

along the shoreline seems to be consistent with day time heating regimes and should be 

removed from consideration. The plume around Bruce A does seem to exceed the 

modelled bounds towards the North. 

Figure 4.10 seems to display better correlation between the scan data and the 

Golder model. Shoreline artifacts are a results of day time heating and should be removed 
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from consideration when assessing the spatial bounds of the Golder model. It is 

interesting to note that the Golder model did not account for temperatures above 10°C 

around Bruce B; though, the thermal scans did show temperatures above the model. Some 

of data to the north does seem to display characteristics of noise from poorly calibrated 

IR data. 

Figure 4.11 illustrates areas that exhibited temperatures higher than the 10°C 

threshold. The offshore strips can be classified as poorly calibrated IR data collected by 

the FireMapper 2.0 system. Bruce A did exhibit some temperatures above 10°C which 

still falls within the stipulations of the Certificate of Approval issued by the MOE. 

Shoreline temperatures artifacts are a result of day time heating. Figure 4.12 displays a 

compilation of all 13 scans used for this project segregated by temperature class. Similar 

to Figures 4.6 to 4.11, some uncalibrated passes are evident within the dataset.  

 

    

 

  



44 
 

 

Figure 4.5 

Culminating comparison of multiple FireMapper 2.0 data sets and the Golder and 
Associates model. The x-axis represents the temperature interval (above ambient) in 
degrees Celsius. The y-axis represents the percentage of the study area occupied by that 
value. The “x” within each dataset represents the mean of the dataset. The line within the 
box represents the median of the dataset. The individual dots within each column 
represent outliers within the dataset. 
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Figure 4.6 

The gray area represents all the data from the 13 scans that was 2 degrees above ambient. 
The dashed line within the study area represents the maximum extent of the 2-degree 
isotherm based on the CORMIX model presented by Golder and Associates.   
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Figure 4.7 

The gray area represents all the data from the 13 scans that was 4 degrees above ambient. 
The dashed line within the study area represents the maximum extent of the 4-degree 
isotherm based on the CORMIX model presented by Golder and Associates.   
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Figure 4.8 

The gray area represents all the data from the 13 scans that was 6 degrees above ambient. 
The dashed line within the study area represents the maximum extent of the 6-degree 
isotherm based on the CORMIX model presented by Golder and Associates.   
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Figure 4.9 

The gray area represents all the data from the 13 scans that was 8 degrees above ambient. 
The dashed line within the study area represents the maximum extent of the 8-degree 
isotherm based on the CORMIX model presented by Golder and Associates.   
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Figure 4.10 

The gray area represents all the data from the 13 scans that was 10 degrees above 
ambient. The dashed line within the study area represents the maximum extent of the 10-
degree isotherm based on the CORMIX model presented by Golder and Associates.   
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Figure 4.11 

The black area represents all the data from the 13 scans that was higher than 10 degrees 
above ambient.  
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Figure 4.12 

This diagram illustrates all temperature classes for all 13 scans used in this project 
analysis.  
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5.0 - Discussion 
 

5.1 – Comparing FireMapper 2.0 with Surface Sampled Data 

 Based off the results of the t-test in Table 4.1, the statistics would suggest 

rejecting the hypothesis that the means of the temperatures collected from FireMapper 2.0 

and the surface temperature probes are related. Figure 4.1 visually confirms that both 

samples do not directly correlate, but the form of the data suggest that there is an offset 

relationship between both datasets. The correlation coefficient does support this claim as 

the r value of 0.83 and the r2 value of 0.69 do indicate some correlation. After examining 

the dataset, it was quite evident that there was one significant outlier that would make a 

significant impact on the correlation coefficient (probe 071). Due to the lack of 

information available for probe 071, it is difficult to surmise what exactly caused this 

dramatic change in value. Without having access to specific probe calibration data or 

annotations from the agency in charge, it can only be assumed that either this probe 

experienced a malfunction that caused an error in the temperature recording; or the 

FireMapper 2.0 system lost calibration by that point in the collection that the quality of 

the data degraded. When probe 071 was removed from the dataset and the correlation 

coefficient was recalculated, the r value increased from 0.83 to 0.90 and the r2 value 

increased from 0.69 to 0.84. In a similar study that compared airborne TIR data with 

ground samples, the group determined that the difference in temperature spread increased 

significantly in temperature >80°C (Harvey, Rowland and Luketina, 2016). It is believed 

that this phenomenon did not exist with this dataset as all temperature were significantly 

lower in comparison and more stable across the scene. 

 The average difference between both datasets was calculated to be 4.54°C. It is 

still unknown why this offset exists. Previous studies utilizing FireMapper 2.0 technology 

to image water temperatures reported an average difference of 0.65°C which translated to 

the FireMapper 2.0 data being 1.89% higher than the datalogger measurements (Hillyard 

and Keeley, 2012). It was initially hypothesized that a similar offset could be seen in this 

dataset. When examining the method in which the surface water temperature data was 

collected, it is believed that some error was introduced through the positioning of the 
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probes. The current methodology has probes submerged slightly below the surface and 

anchored to the floor of the lake. It can be surmised that a probe that is 1 meter below the 

surface would provide relatively similar surface data, but this does introduce a degree of 

inaccuracy to the methodology. Since these probes are tethered, there could be some error 

in the surveyed coordinate and the actual position of the probe. Furthermore, it was 

indicated that some probes did show signs of movement after the spring thaw. It is 

believed that probes that were closer to the surface may have frozen to the surface at the 

peak of winter and as ice separated in the spring, the masses of ice may have had enough 

force to move the probe anchor point. It is possible that this freeze thaw cycle could have 

affected some of the instrumentation. Unfortunately, minimal information is known about 

the construction, operation and calibration of the surface water temperature probes and it 

is therefore difficult to hypothesize what could have caused the difference. 

 With regards to FireMapper 2.0, there are a few known items that could have 

caused inconsistencies within the data collection. FireMapper 2.0 allows the operator in 

the aircraft to view thermal data real time when the camera door is open. When the 

operator selects the door closed, a manual door closes and exposes the IR sensor to a 

black body that allows the microbolometer to recalibrate. The benefit to this procedure is 

that hypothetically the sensor should recalibrate between each pass ensuring consistence 

between flight lines. Referring to Figure 5.1, based on the graphical representation of the 

degradation curve it can be inferred that FireMapper 2.0 is capable of providing reliable 

data for up to 9 minutes of not being exposed to the blackbody calibration. After 9 

minutes, there is a slight decrease in the sensors abilities to maintain calibration. This 

could have affected the results of the data that was acquired; more so for the data 

collected on 6 August 2015 as the acquisition area increased significantly on this flight 

specifically. Typical flight lines for the standard study area were 2-3 minutes in length to 

complete. For data collected on 6 August 2015, this time increased to 9-10 minutes per 

flight line. Based on data collected on 6 August, it is quite possible that the ends of each 

pass could be laden with inaccuracy. Furthermore, some of the “anomaly streaks” within 

a specific data set could be a result of the calibration not being selected between passes. 

Unfortunately, there is no means to assess how long it was between sensor calibration 
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post flight. It would be beneficial for the sensor vendor to develop a flight log that 

provide additional metadata to the end user post flight of the quality of the captured data. 

 The quality of the spatial accuracy was also concerning and believed to be a 

limitation of the dataset. The methodology proposed in this study does provide some 

quality control outputs, but there is no r or r2 value generated during the mosaic process 

that would allow the user to ascertain the level of confidence in the product. Furthermore, 

the proposed method differed greatly from traditional photogrammetric data capture as 

there were no established ground control points or base stations to provide added spatial 

accuracy. Manual point samples were assessed for location accuracy based off base map 

data, but this non-scientific approach does not provide a numeric confidence value. As 

well, without having absolute survey points over the water laden data made it difficult to 

assess the positional accuracy of the data.  

 Another limitation of this study was the timing of acquisition. The location of 

each temperature probe was provided and the temperature for each probe was recorded 

every 15 minutes. Unfortunately, it was near impossible to sync the individual aerial 

passes with the acquisition interval of the temperature probe. As a result, the average of 

each probe was calculated over the span of the data acquisition. Probes were ordered in 

sequence of acquisition for the purpose of correlating the temperature values, but the 

correlation coefficient seems to deter the thought that there would be a gradual increase 

or decrease during the two hours of acquisition. This could be a result of a low 

temperature spread of the ambient air temperature and ambient water temperature at the 

time of the scan. Furthermore, the scan was completed around Solar Noon, which is still 

prior to the peak temperature for the day. Although this method in comparing surface 

borne data to airborne data is not perfect, it does not seem to have a significant impact on 

the results of the correlation. If this study were to be repeated though, there would be 

great benefit to aligning surface temperature collection with airborne collection to 

enhance the accuracy of the output and reduce the degree of uncertainty. 

 For this portion of the project, it was believed that point temperatures from the 

raster layer would provide sufficient representation of the airborne thermal data. Though, 
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it could also be argued that it is more beneficial to take an average temperature of the 

surrounding area to normalize any potential fluxes in the data capture. Since this project 

had no control over the placement of the surface temperature probes and the temperature 

values are significant to the outcome of the results (regardless of how miniscule the 

change), the averaging method was dismissed. In the future, there would be great benefit 

to testing these two methods to understand which better represents the data. 
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Figure 5.1 

Drift in the microbolometer system with the offset-blackbody correction disabled. Drift in 
the microbolometer array produced a 62°C error in scene temperature in a narrow-band 
channel when viewing the reference blackbody for 90 minutes. Temperatures estimated 
from the broadband channel and from a thermocouple are also shown. The “11.9 
micrometer” annotation refers to the 11.4 – 12.4µm channel (Riggan and Hoffman, 
2003). 
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5.2 – Comparing FireMapper 2.0 with Landsat 8 TIRS Data 

 Based on the results, it does seem like there is a strong correlation between the 

temperature data collected by Landsat 8 TIRS and FireMapper 2.0. The strong correlation 

values are indicative that the sample temperature points were accurate. Furthermore, the 

average difference between sample temperatures was 0.56°C, which could be seen as 

trivial as there was a delay in data capture. This differential could simply be a function of 

time. As mentioned in the previous analysis, there was some hesitancy to use specific 

pixel values to assess the temperature from the FireMapper 2.0 dataset. Due to the nature 

of Landsat 8 TIRS acquisition, the thermal raster layer was consistent within the frame 

and there were no visible blemishes that would obscure analysis. This is unfortunately 

difficult to recreate with frame-based sensors as the post processing requires these frames 

to be stitched with reference to high quality GPS data. These differences in methodology 

do skew the ability to interpret the data. 

 The results from the linear transect comparison in Figure 4.4 further support the 

argument that the Landsat 8 TIRS and FireMapper 2.0 data had strong correlation. The 

linear transect did show lower correlation values in comparison to the random point 

sampling in Figure 4.2. For instance, the r value for the random points was 0.98 whereas 

for the linear transect this value decreased to 0.93. In terms of r2 values, the random 

points generated a value of 0.97; whereas the linear transect generated an r2 value of 0.87. 

It is believed that this decrease in correlation is a result of the fact that the increase in the 

complexity of the transect data. As denoted earlier, there is some inherent inaccuracy 

within the spatial positioning of the FireMapper 2.0 data. As a result, the more similar the 

surrounding temperature values are, the more likely there will be less induced error. If 

surrounding pixels have higher fluctuation in temperature values, there is a higher 

probability of selecting a neighbouring pixel that misrepresents the sample point. 

If a frame-based solution is still sought after in the future, more attention should 

be placed on ensuring the sensor itself can generate balanced frames of data. For instance, 

Figure 5.2a and Figure 5.2b highlight some of the difficulties of imaging water as it 

presents a single frame of thermal data captured by FireMapper 2.0 over water and over 
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land. It would be reasonable to hypothesize that if a body of water had a similar 

temperature with minimal variation, the resulting thermal frame of data would be 

homogeneous throughout. There may be slight variation due to small temperature fluxes 

within the scene, but overall it should have minimal variation. Instead, Figure 5.2a 

illustrates an odd pattern that persists in each scene captured over water. This suggests 

that the physical sensor in the FireMapper 2.0 system is incapable of imaging areas with 

little to no change in temperature. In contrast, Figure 5.2b illustrates that ground cover 

with sharp contrast results in a clear image. It is therefore believed that flying these 

campaigns at night might remove some of the unnecessary error introduced into this 

capture. 

When assessing the variability of the difference in the data, it was initially 

hypothesized that the trend line in Figure 4.3 would uncover a positive trend. The 

assumption being that the scan with FireMapper 2.0 was commenced two hours prior to 

the capture of the Landsat 8 TIRS data. Therefore, it would be safe to assume that data 

sampled first would be cooler than the remainder of the dataset. Surprisingly, the 

calculated trend illustrates a negative trend which does not support the initial hypothesis. 

Some contributing factors that could have led to this discrepancy could be the difference 

in spatial resolution of the datasets, changes in sensor calibration of the FireMapper 2.0 

platform; or it could simply be that under these conditions and this time of year, two 

hours is not a sufficient amount of time to generate significant differences over the two 

datasets and therefore the trendline is not indicative of anything. This is further supported 

by the fact that the correlation coefficient of the trendline was relatively weak. 

Another interesting relationship that was uncovered during this study was the 

strong correlation and similar trend of both suspended thermal platforms but the large 

disconnect from the surface-based probes. Unfortunately, very little was known about the 

design and operation of the temperature probes that were used for this study. In the future 

it would be interesting to complete a study that compared all three technologies at a 

single point in time. Furthermore, it would be worth validating the FireMapper 2.0 sensor 

by capturing data over a test site with a controlled temperature facility. Utilizing multiple 

ground-based thermometers to ensure a consistent temperature would enable a better 
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comparison of ground based and airborne collected data. If multiple scan were to be 

completed of the Bruce Power Complex again, it is suggested that a calibration point be 

established at the facility. This point should be located within the study area, ground 

truthed for spatial accuracy and automated to ensure the target is consistently the same. 

This would allow each subsequent scan to be calibrated daily. Furthermore, more 

consideration should be placed on understanding how weather information alters the 

outcomes from the thermal sensor. 

 Spatial resolution was another variable that could be further analyzed as a result 

of this study. The majority of the FireMapper 2.0 scans were completed to generate a 2-

meter resolution data set with one of the final scans being completed to provide 7-meter 

resolution data. Figure 5.3a provides a thumbnail of the data collected by FireMapper 2.0 

on 6 August 2015. The Landsat 8 TIRS capture provided 30-meter resolution data of the 

target area. Figure 5.3b provides a thumbnail of the data collected by Landsat 8 TIRS on 

6 August 2015. Comparatively, these two figures illustrate how much a data set can 

change simply by changing the spatial resolution. It is believed spatial resolution did 

affect the results at various points as point values collected by surface probes are 

capturing single point data for a very small area; whereas, airborne thermal sensors 

average the temperature within a pixel and assign the pixel that value. Therefore, 

localized fluctuations within a pixel are essentially averaged out. At the start of this study 

it was believed that finer resolution data was required to allow for proper delineation of 

the thermal effluence. Based off the data compiled for this study, it seems that 2-meter 

resolution data may have been unnecessary for thermal plume delineation. Although it 

did provide good information of the study area, it is believed that 10-meter resolution 

data would provide the same level of information but allow the platform to cover more 

ground in a single flight. It was noted though that 30-meter resolution data may have 

been too coarse for this study. It is believed that the statistics generated by this study do 

have some bias as the study area was specifically picked to encompass what was 

hypothesized to be the bounds of the thermal effluent. Ultimately, this area has lots of 

thermal variation that is ideal for calibrating thermal sensors, but when attempting to 

correlate this data to point samples, error is introduced. This study further brings to light 
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the ability of thermal sensors to provide good overview data but falls short when looking 

for site specific values in a micro scale. 

When reviewing the three methods proposed in this study, satellite-based methods 

provided ideal coverage for a large-scale area. The limitations were accessibility to the 

data, revisit time of the asset and operating cost. All these variables make it difficult to 

employ this technology for operational monitoring. If cost were of no concern, 

geostationary satellites do provide continuous monitoring of a fixed point on the earth, 

but weather would still remove the reliability of data capture. Furthermore, similar to 

satellites, airborne platforms are still bound by weather. It was also suggested that 

weather and time of day should be of higher significance when planning thermal capture 

missions. UAVs are also re-entering the workspace as the technology is becoming more 

affordable and obtainable. These three technologies should be seen as multiple tools that 

can assist in monitoring thermal effluent, rather than single solutions that are better than 

the rest. What is critical moving forward is engaging operations staff to understand what 

scale of detail is required to help frame the technology. 
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Figure 5.2a 

Single frame captured over water (within the study area) by the FireMapper 2.0 thermal 
system on 6 August 2015. 

 

Figure 5.2b 

Single frame captured over land (within the study area) by the FireMapper 2.0 thermal 
system on 6 August 2015.  
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Figure 5.3a 

Clip from mosaic generated using FireMapper 2.0 thermal data acquired on 6 August 
2015. 

 

Figure 5.3b 

Clip from single frame of Landsat 8 TIRS data captured on 6 August 2015. 
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5.3 – Comparing FireMapper 2.0 Data with Modelled Data 

 From Figure 4.5, it is evident that the airborne data does partially support the 

proposed Golder model. The figure suggests that on any given day, the percentage area 

the plume segments occupied did not exceed what was modelled. This was true for each 

2-degree segment modelled. The airborne data does not fully support the temperature 

segment boundaries that are published within the Golder model. This should be said with 

caution though as the Golder model does use a slightly different methodology than what 

is proposed in this study. This does raise questions on what is the level of importance of 

the spatial boundary of the modelled plume? The airborne thermal data supports the area 

values published by the model, but the compiled boundaries do suggest that the Golder 

model may need further refinement. 

 As previously mentioned, there are a few differences in methodology which could 

explain some of the differences seen between the Golder model and the acquired thermal 

data. The Golder model was generated utilizing a variety of inputs that were measured in 

the field over a prolonged period of time. The model reflects the current process used by 

Bruce Power to regulate their thermal output. This study did not have access to these 

published values which is a large limiting factor of the results. The Golder model 

assumes that regulating temperature is obtained from off site, shore-based facilities; 

whereas the airborne model is based off a 1-hectare sample site that is far from the Bruce 

facility. It is therefore possible that ambient values that were used in the airborne thermal 

model could vary significantly from what was utilized operationally. Changes of 0.5°C 

could significantly affect the outcome that has been suggested in this project. It is also 

suggested that should this type of study be replicated; more effort should be placed on 

obtaining the operational output temperatures at the time of the scan to ensure the results 

being provided are valid.  

 An additional limitation of the FireMapper 2.0 model is the time of day that the 

data was captured. The majority of the airborne scans that were completed near solar 

noon. In previous studies, TIR data has been captured at night to remove the influence of 

solar heating and the generation of false positives (Neale, et al., 2016). During the initial 



64 
 

planning of this project it was determined that it was more critical to capture daytime 

imagery as it would represent the peak output of each reactor on a given day. In selecting 

this time to scan, it is evident from Figures 4.8 – 4.11 that daytime heating did influence 

the acquired data. Cloud cover was not considered to be a critical deterrent for data 

capture as having data in different wind conditions was prioritized as more critical than 

minor anomalies within the datasets. Flights were launched so long as the aircraft could 

remain below cloud for the duration of the scan. The data in this study does not suggest 

that more emphasis should be placed on capturing cloud free data; but rather, the time of 

day needs to be modified to remove the influence of localized daytime heating from the 

dataset. In an effort to generate a more robust aerial model, it is suggested in the future 

some data should be captured at night to provide comparative datasets and assist in 

understanding the influence of daytime heating on the study area. To further remove the 

potential influence of cloud cover, it is suggested that future data acquisition be 

completed in either sky clear conditions or with a uniformed overcast condition to 

diminish localized influences within the data set.  

 There is some variability built into the FireMapper 2.0 model as each scan was 

typically completed to image the plume under a specific wind condition. Scans were 

focused on the summer and winter season to populate the model with anticipated 

maximum and minimum values. In 2013, a significant number of scans were completed 

in the winter as the climate kept the shores of Lake Huron ice free for the entire season. 

In contrast, this data collection was near impossible in 2014 as more than 90% of Lake 

Huron was ice covered by the end of the winter season. Effort and emphasis was placed 

on attempting to capturing thermal data during conditions where TMAX could be reached. 

Unfortunately, the opportunity did not arise during the study period as weather and 

climate conditions did not produce the right conditions to facilitate this event. After 

reviewing the collected data, it is evident that there were only 2-3 scans within the entire 

data set that had ambient temperatures above 20°C. It is therefore believed that the 

proposed FireMapper 2.0 model does not account for extreme conditions.  

 As mentioned in the other sections of this study, geospatial accuracy was a 

primary concern with regards to the findings. The results of the thermal scans could have 
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been enhanced if the PPP method was used to generate the EO file. The PPP method was 

not utilized for this study as an assessment was also being made on how quickly this data 

could be augmented into the operational structure of Bruce Power. PPP typically requires 

data to be downloaded 24 hours post flight to help condition the collected signal. GPS 

enhancements could have been made to ensure the INS data being gathered was as 

accurate as possible. The GPS signal received by the aircraft for this study was Single 

Point L1/L2 which would mean the end user could anticipate an accuracy of 1.5 meters at 

the sensor. It is believed that subscribing to a Differential Global Positioning System 

(DGPS) or a Real Time Kinematic (RTK) based solution would have enhanced the results 

significantly and would have resulted in lower spatial inaccuracy. Adding a calibration 

monument that was surveyed with a known temperature would facilitate in conducting 

proper accuracy assessments post flight. When the FireMapper 2.0 system was in 

development, the concept of “structure by motion” was still in its early stages of 

development. Coding for mosaic generation heavily relied on accurate GPS data and a 

good calibration solution for positional offsets. The overall accuracy of the datasets 

developed for this study are estimated to have a spatial error of ± 25 meters. This is 

mainly due to lower frequency GPS signals, the inability to generate a very accurate 

boresight calibration solution and low quality automosaic techniques. 

In recent years, significant developments have been made in mosaic image 

processing and it is conceivable that some of this historic data could be reprocessed to 

provide a better solution. Some initial evaluations have been completed using software 

that utilizes both Automatic Triangulation (AT) and GPS position to generate a mosaic 

product. These software solutions also provide better colour balancing solutions that tend 

to enhance the final product. These software solutions provide amazing results for 

multiband data, but still struggle in coarse pixel mosaics; especially over homogeneous 

features like water. There have been some very recent advancements in the coding for 

coarser data, but the overall success of this technique has yet to be evaluated. Some 

attempts were made to use these software processes to generate a more contiguous 

mosaic of the study area, but data dropped out quickly as there was not sufficient overlap 

to satisfy the operational requirement of the post processing software. 
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5.4 – Future Technology 

For this study, FireMapper 2.0 was utilized as the means to collect airborne 

thermal data as it was the only affordable technology available at the time. During the 

integration of FireMapper 2.0, a variety of technologies were being developed that were 

pushing the boundaries of airborne thermal acquisition. As of 2017, the market currently 

has many viable solutions with wider FOV’s, more cross track pixels and larger sensor 

sizes that are a fraction of the cost. Upgrading to these low-cost sensors would allow an 

aircraft to fly higher and fewer lines while obtaining comparable data. Prior to conducting 

this study, it was decided that a frame-based solution was sought after as it was seen as 

affordable and reliable. Line scanning technology has come a long way in recent years 

and is more obtainable to the masses. Most recently, vendors like ITRES have been able 

to design a micro scale thermal line scanner that can affix to a UAV. The quality of data 

obtained by these micro sensors are now superior to the data collected for this study. 

At the start of this study, UAVs were seen as a potential future solution to 

imagine thermal emissions, but the cost was still prohibitive. The rapid growth of the 

hobby market has created an opportunity to revisit this technology for this application. 

From the literature currently available, it seems that there are still limitations to the 

technology that may see solutions in the next five years. Battery capacity still seems to be 

the largest hinderance to the success of this technology. Most off the shelf solutions are 

battery powered and adding an accurate thermal sensor with good GPS greatly reduces 

the flight time of these units. With more investment being placed on battery technology, 

it is conceivable that this will not be a problem in the next decade. 

Full Motion Video (FMV) sensors have also become more available to the 

commercial market, partially in thanks to the emerging UAV market and the continual 

declassification of military grade sensors. FMV data provides a new dimension to thermal 

effluent mapping and monitoring as aerial assets can now loiter over a specific site and 

record thermal video of the effluent. The results of this data could potentially assist in 

redefining computational models as the visual characteristics could be compared to those 

of the FMV data. Most of these sensor packages are capable of providing geocoded video 
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that can be panned around the scene and can be zoomed in for more detail. Delineation of 

boundaries no longer must be done from a static model but can be done ad hoc as the 

sensor is on orbit over the target area. There are still limitations to FMV type sensors, but 

it does add an interesting layer to the advances in technology.  
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6.0 - Conclusions 

 This study has been successful in providing initial assessments to the strengths 

and weaknesses of the various technologies utilized. Through the comparison of 

FireMapper 2.0 and surface-based sensors it became evident that temperature profiles 

were similar between both technologies, but a significant offset did exist between the two 

data sets. The rational for this offset remains unknown but this study has proven that 

more surface-based validation is require and on-site calibration would help validate 

individual datasets. The comparison completed between FireMapper 2.0 and Landsat 8 

TIRS uncovered that both technologies yielded similar results with regards to temperature 

profiles, but large differences did exist between the spatial accuracy of the data. 

FireMapper 2.0 data was difficult to assemble as water added additional degrees of 

difficulty to generate a useable mosaic; whereas, Landsat 8 TIRS was able to provide a 

“big picture” outlook of the study area in a single frame with remarkable accuracy. 

FireMapper 2.0 did provide means to assessing the accuracy of the CORMIX 

computational model, but this assessment was based on many assumptions and future 

studies need more access to regulatory control data to allow for the proper assessment of 

model accuracy. Through the various comparisons, it was clear that the FireMapper 2.0 

system was limited in its abilities. Being a frame-based solution, there were many 

obstacles to overcome with regards generating a spatially accurate mosaic that could be 

used for analysis. As mentioned earlier, water did prove to be a difficult subject matter to 

represent accurately using each method. Since data was captured between 2013 and 2015, 

the FireMapper 2.0 thermal system has become obsolete. With newer technologies now 

available that would allow for larger areas of data collection with a finer resolution, it 

would be suggested very beneficial to conduct similar studies to assess abilities of these 

newer technologies. 

Ultimately, this study has shown how thermal technology can add a new 

dimension to understanding complex thermal issues that influence the environment. 

Surface probes seemed to be the most cost effective and accessible means to collect data. 

Weather rarely limited the ability to collect data and advances in technology could easily 

remove the necessity to retrieve data physically from these points and instead rely on 
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local networks to send data remotely as it is collected. Landsat 8 TIRS did provide 

stunning data at a reasonable resolution, but it was still greatly limited by weather and 

revisit times. This technology is great for research where time of capture is not always a 

necessity, but it definitely has limitations when adapting this technology into a regulatory 

practice. FireMapper 2.0 was a good “in between” solution to the aforementioned 

technologies. It was capable of collecting data on demand and in overcast conditions, but 

the design of the platform did limit the accuracy of the resulting data. Regardless of the 

platform, all the data collected did assist in providing a new dimension to the 

environment surrounding Bruce Power. As such, it is highly recommended that this data 

be augmented into new forecast models to provide another layer of factual data. 

Nuclear power generation will continue to provide a critical form of clean power 

generation for the foreseeable future. Generating a better understanding of the 

environmental impacts of this form of power generation should steer future upgrades and 

construction to ensure the environmental impact remains minimal. The current regulatory 

atmosphere in Canada should act as a model for the remainder of the world as there 

seems to be a good balance between regulation and environmental impact. Regulations in 

Canada ensure outputs are monitored and actioned appropriately to ensure there is 

minimal impacts on local ecosystems. This should be considered an international 

standard for developing countries that are looking to nuclear power as a means of 

providing more power to a stressed system. 
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Appendix Q: FireMapper 2.0 - Data Processing SOP 

Before Processing: 

1. Insert blank memory card (USB) & SPAN (SD Card) in the laptop 

Getting Started: 

1. Attach PCI key dongle in USB port 
2. Open Geomatica 10.3 
3. Click on “EASI” in the tool box that appears, once it opens type: 

a. EASI>run firemapsetup    
b. EASI>projname=”(insert project name here)” 
c. EASI>run projectsetup 

*** Note: This creates all of the necessary folders you will be using in the Firemap Projects Folder. Before 
continuing with EASI, minimize the screen and start the SPAN processing 

4. Copy & Paste Span data from memory card into your project file, in the “Spandata” 
folder 

5. Copy & Paste IR data (.dat files only) from USB into your project file, in the 
“rawdata” → Firemapper folder 

SPAN Processing: 

1. Open up Inertial Explorer 8.50 
2. Go to “File” → “New Project” → “Empty Project” (Save it as (project name) in your 

project folder → “Spandata”) 
3. Go to “File” → “Convert” → “Raw GNSS to GPB” 

a. Click on “Get Folder” → Go to “(your project folder)” → “Spandata” → 
“OK” 

b. In Source File click on “SPAN_0.LOG” → ”Add” → ”Yes” to NovAtel 
OEM4/OEMV/OEM6 

c. Click on “Global Options” → Make sure the following are checked in or that 
the numbers are matching: 

For project name, enter 

“NOSM, YYYYMMDD, KIN” 
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4. Click “Convert” → Once the process is complete; click “Close” → Click “Close” 
again. 

5. Go to “File” → “Add remote File” → “SPAN_0” → “Open” → “OK” → “Yes” → 
“OK” 

6. Go to “File” → “Add IMU FILE” → “SPAN_0” → “Open” → “OK” 
7. Go to “Settings” → “Datum” → Change the Processing Datum to “NAD83” → 

“OK” → 
a. A pop-up screen will appear confirming that you are changing the Datum. 

Select “OK” 
8. Go to “Output” 

a. Under the “Select Plots”’ tab, click on “Plot Results” → “Quality Control” 
→ “File Data Coverage” (Verify that the IMU and Remote File have been 
uploaded) → “OK” → “X” out. 

9. Go to “Process” → “LC (Loosely Coupled)” 
a. In the drop-down menu for “Update Data”, change it to “External Trajectory” 
b. Click on “Browse External” → type in File name: “*.fsp” → Click on 

“BESTPOS.fsp” → “Open” 
c. Make sure the Profile is “SPAN Airborne (CPT)”, check the Filter Profiles 

box 
10. Change the “Lever Arm Offset” → “Z: 1.000” (this is a standard number used for 

lever arm offset) 
11. Click on “Advanced” → “Updates”: 

a. Change the “GNSS Pos”: 100.0, and the “Range”: 20.0 → “OK” (these are 
standard numbers used for GNSS Pos. and Range) 

b. Uncheck “GNSS Velocity Updated” 
c. Click “OK” to exit the “IMU Processing Settings” Menu 
d. Click “Save Settings”, then → “Process” 
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12.  Go to “Output” 
a. Under the “select plots” tab click on → “Plot Results” → “IMU” → “IMU-

GPS Position Misclosure” → “X” out once you have verified the results. 
13. Go to “Process” → “Smooth Solution” 

a. Solutions to smooth: “LC Solutions (both directions present)” 
b. Verify that “Smooth both directions and combine” is selected 
c. Check the “Smooth entire time range” box 
d. Click on “Smooth” 

 
14. Once the program is smoothing the data, you can check the box that says “close when 

finished” or, simply close the box manually once it is done processing. 
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Exporting Span Data (EO.txt): 

1. Go to “Output” → “Export Wizard” → 
a. Save the file as “(project name).txt” in the “Spandata” folder 
b. Source: “Epochs” 
c. Profile: “Discovery Air-PCI” → then click “Next” 
d. Confirm “NAD83” → then click “Next” 
e. Ensure the correct UTM Zone is selected → then click “Next” 
f. Ensure the correct UTM zone is carried forward → then click “Next”  

2. “Average Ground Height” – 0.000 (this is a standard number used for average ground 
height) 

a. “C:/NovAtek-IE840-Geoid-GPS-HT2-Canada.wpg” → then click “Next” 
3. Time interval “0.1” seconds → then click “Next” (this is a standard number used for 

time interval) 
a. Axes definition - Grid: “UTM, Zone 17” 

i. Order: W-primary, P-secondary, K-tertiary (gnd-to-air) 
ii. Axes: X-right, Y-forward, Z-up 

iii. Boresight Angles: Make sure the box is checked, Select Firemapper 
from list → then click “Next” 

4. UTC Time Offset = “16” (this is a standard number used for UTM Time Offset) → 
then click “Next” → then click “Finish” 

Firemap Workflow 

1. After the SPAN data has been processed, go into “Spandata” folder → Find “(project 
name).txt”, copy & paste it to the (Project name folder) → “Rawdata” → “Firemap” 
folder 

2. Once it is copied, rename it to “EO.txt” 

Processing Firemap using EASI: 

Once the Exterior Orientations .txt file is created, open up EASI. 

1. Click on “Geomatica 10.3” and open up EASI 

.   

 
2. Type: 

EASI>s  firemap 

3. The default settings will appear.  Change the following settings: 
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EASI>PROJNAME=”(project name)” 

EASI>SUBSET=”YES” 

EASI>FMTHRHLD=0 

EASI>FILEDEM=”C:/FireMapEnv/dem/ontdem.pix” 

EASI>MAPUNITS=”UTM 17 D000”  

4. Now that all your settings for firemap have been changed, type: 

EASI>r  firemap 

Note: This process will take a while. Once completed, the dialog box will close automatically. A 
thermal mosaic will generate in both .TIF and .PIX format. These can be located in: 

“(project name)” Folder → “OUTPUT” Folder → “firemap” Folder → “mosaic” Folder 

 

 


